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1 Introduction 

Unscrambler X Process Pulse was designed to be an easy to use and versatile software package for real 

time monitoring of processes utilizing a wide range of process analysis equipment. Combining the power of 

multivariate models with intuitive plot configurations and automatic alarm systems Unscrambler X Process 

Pulse is an invaluable tool for detecting and correcting deviations from target process conditions. Process 

monitoring is based on models for prediction or classification previously trained and validated using The 

Unscrambler® X multivariate analysis software. The state of a process or product quality attributes can be 

measured in real-time with equipment such as process spectrometers or other process analysis inputs.  

Unscrambler X Process Pulse supports most of the common data formats, both vendor-specific and 

generic. It can be connected via OPC or through a Programmable Logic Controller (PLC) using 

communication protocols such as TCP/IP etc. A set of pre-specified diagnostic plots can be configured and 

displayed on a computer screen or other Human Machine Interface (HMI) and updated as new samples 

are being measured. These plots can be used by process operators or quality assurance to identify any 

anomalous or deviating samples, while interactive drill-down options enable detailed investigations of raw 

data. The prediction and classification results, as well as a list of any deviating samples, are written to 

output folders for subsequent investigation and analysis. A flow chart is provided in Figure 1 depicting a 

typical workflow. 

 

Figure 1 - Data Flow Chart 

 

 

1.1 Assumptions and General Statements Regarding Unscrambler X Process Pulse 
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For the purposes of setting up configuration methods in Unscrambler X Process Pulse, the reader of this 

document should have a sound working knowledge of multivariate predictive and classification models 

used for real time analysis purposes and in particular, should have worked with The Unscrambler® X 

product. 

Routine users of the program do not necessarily need a full working knowledge of multivariate modeling 

but should be familiar with the output and plot interpretation associated with each plot. 

Unscrambler X Process Pulse is a simple monitoring tool for general process applications and in of itself is 

not a control system. However, it is customizable to specific user requirements and the outputs generated 

can be used by third party systems for control applications. Contact your local CAMO Software office for 

more details on customization of the package. 

 

1.2 Typographic Conventions 

Throughout this document, the following typographic conventions are followed. 

 A User is defined as a person who uses the Unscrambler® X multivariate analysis software and/or 

Unscrambler X Process Pulse software. 

 

 A Configuration method is a pre-defined list of instructions for performing a prediction or classification 

routine. The configuration methods contain the multivariate models developed in The Unscrambler® 

for real time prediction and classification purposes. 

 

 The Configuration navigator is a side pane in the main startup screen that contains the configuration 

methods available to a user for the application of real time prediction and classification models to new 

data. 



Unscrambler X Process Pulse 1.0 – User Manual 

_______________________________________________________________________________________________ 

_______________________________________________________________________________________________ 
9  © Copyright CAMO Software 

2 Getting Started  

This section describes the general usage of Unscrambler X Process Pulse software package.  

 

2.1 Package Contents 

Unscrambler X Process Pulse installer comes with the file UnscramblerXProcessPulseSetUp.msi. This 

file is used for installing the program. 

A step-by-step installation procedure is provided that guides a user through the setup and activation of the 

software. 

Please Note: An installation and operational qualification document is available for the setup procedure. 

Please contact CAMO Software if you require this document. 
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3 Application Startup 

After successful installation of the software, launch the application by double clicking on the application 

icon available on the desktop or by clicking on Unscrambler X Process Pulse 1.0 menu from programs list. 

An activation key will be requested when the application is launched for the first time. 

 

3.1 Activation dialog 

Upon launching the application for the first time, an activation dialog will appear (see Figure 2).  Users with 

a working internet connection may use the Obtain button to request an activation key online. Make sure 

the fields Machine ID, Name and Company are correctly filled in. A user may also contact their local 

CAMO office directly to obtain the activation key. 

 

Figure 2 - Activation Dialog 

3.2 Login dialog 

Once the software is activated, a login screen will be displayed upon startup (see Figure 3). The default 

and recommended option is to log on using windows authentication credentials. This will provide a 

traceable signature stamp in the audit trail contained within the software.  

 

Figure 3 - Default Login Dialog 
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For testing purposes or other situations where traceability is not required, the windows authentication 

option may be de-selected and the user may log on as Guest. A warning will be displayed as shown in 

Figure 4 stating the data will be collected in non-compliance mode. 

 

Figure 4 - Guest Login Dialog 

A splash screen with the program branding and version details will appear for approximately 3 seconds 

when the Login button is selected. After this, the user will be taken to the Startup Screen. 

 

3.3 Startup Screen 

The startup screen is shown in Figure 5. In addition to the main work space, a list of configurations is 

displayed on the left side pane (if any have been previously configured) called the configuration navigator. 

A pane for configuration info is displayed at the bottom of the screen, and a set of menu items and tools 

are provided at the top of the screen. If the program has been installed for the first time, no configuration 

methods will be displayed in the configuration navigator. 

 

Figure 5 - Startup Screen 

Main work space 

Menus and Toolbars 

Configuration 

Navigator 

Configuration Info 
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3.4 Configuration Method Setup 

In order to use Unscrambler X Process Pulse application for prediction and/or classification purposes, the 
following are essential: 

 The Unscrambler® X model(s) 

 File path location for storing the samples from a data source (spectrometer or other) 

 File path location for storing the results of prediction or classification routines. 

A file that stores these parameters is referred to as a configuration method. 

Unscrambler X Process Pulse facilitates creation of new configuration methods, along with the abilities to 

modify, duplicate and delete existing configuration methods. Section 3.4.1 describes how to set up 

configuration methods for predictive models and section 3.4.2 describes the corresponding procedure for 

classification models. 

 

3.4.1 Creating a Configuration Method for Prediction 

To create a new configuration method, click on the New button ( ) in the toolbar or select the menu File 

-> Configuration-> New to start the setup wizard. The options for creating a new configuration method are 

shown in Figure 6.  

 

Figure 6 - New Configuration Menu option 

 

The Create Configuration dialog screen, as shown in Figure 7, will appear. Select  Prediction by clicking in 

the radio button at the top of the dialog. Enter a Configuration Name. Configuration method names can be 

any alphanumeric text (including some special characters like underscore ‘_’, hyphen ‘-‘and opening and 

closing brackets ‘(‘and ‘)’ ), but not a space character. This will also be the name given to the Output folder 

where results will be stored.  

Follow through the tabs and provide the required input information for a particular configuration method. 

This is described in more details in the following sections. 
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Figure 7 - Configuration Dialog 

 The Model Tab 

The Unscrambler® X model files that are to be used for prediction are specified in the Model tab (See 

Figure 7). Only one model can be loaded and used for prediction per configuration method (however, if a 

PLS model with multiple constituents can be used). Each sample that is read in during the prediction 

process is predicted using the model that is selected in the configuration method. New input data should 

have the same number of variables as that used to develop the original calibration model and read in using 

the same order as specified in the model. For this reason, models developed for instrumental data should 

have all the variables, and use the Keep outs option in The Unscrambler® X range definition dialog to 

exclude columns from the analysis rather than deleting columns from the input data when the model is 

developed. 

The Add Button 

To enter an Unscrambler® X model, click on the Add button. The Select Model dialog (as shown in 

Figure 8) will appear where an Unscrambler® X project or model file can be entered, or use the 

Browse button to find a project/file in a specific directory (a standard Windows file selection dialog 

appears that can be browsed to the directory containing the project or model files). An example of 

this dialog is shown in Figure 9. 
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Figure 8 - Select Model Dialog 

 

 

Figure 9 - Open Dialog for selecting Models 

 

If the Unscrambler® X project file is password protected an Enter Password dialog (shown in 

Figure 10) will appear. On entering the correct password, a user can see the list of models in the 

selected project file (see Figure 11). 

 

 

Figure 10 - Password dialog 
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All models in a project will be accessible from the Model drop-down box. Select the appropriate 

model from the list and view the model information displayed for the selected model (see Figure 

11). Click on the Add button to configure the Prediction method. 

Note: Only valid models (full PLS, PCR or MLR models) can be added here. 

Only one model can be loaded for prediction purposes. Please contact your local CAMO Software 

office if a greater number of models is required for a particular application. 

 

 

Figure 11 - Select Model 

 

The Remove button 

Models can be removed from the list by selecting the model from the Model(s) list, and clicking the 

Remove button. The selected model is removed from the list. 

Components 

The number of components to be used for prediction is shown in the Components numeric spin 

box. The optimum number of components for a model is suggested based on information in the 

Unscrambler® X model file, however this may be modified by the user (provided the components 

were not previously saved to a model in The Unscrambler® X) 

Model Information 

Information about the currently highlighted model is displayed in the Model Information section. 
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The Input tab 

Directory 

The sample files generated during the process (i.e. from the process equipment, spectrometer 

etc.) are to be saved into a directory specified here. When the configuration method and process 

are started, input sample files are read from this folder and used for prediction purposes.  A 

Browse button can be used to specify the input directory. An example is provided in Figure 12. 

 

 

Figure 12 - Input tab 

File Format 

The file format of the input files is specified in the File format drop-down box. The file formats 

supported in Unscrambler X Process Pulse are provided in Table 1. 
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Table 1 - File Formats supported 

 

OEM Name Format  Supported File Extensions 

Most of the instrument vendors JCAMPDX *.jdx,*.dx,*.jcm,*.jx,*.jxs 

THERMO GRAMS *.spc,*.cfl 

BRIMROSE BFF3, BFF4 *.dat 

ASD Inc INDICO *.asd,*.asf,*.001 

VARIAN Cary UV-Vis *.BSW 

Bruker OPUS *.0x, *.01 

Thermo OMNIC *.spa,*.spg 

Guided Wave SpectrOn , ClassPA *.asc, *.scn, *.data, *.gva, *.updated, etc 

Foss NSAS *.da,*.DA 

Perkin Elmer Spectrum 6, Spectrum 10 *.sp,*.spp 

 ASCII *.txt,*.csv 

 Excel *.xls,*.xlsx 

 

Watch for New Files 

If this option is set the prediction process is notified whenever a new file is added to the Input 

directory. The new file is loaded and processed once any previous predictions have been 

completed. 

This option is for the so called asynchronous mode of operation. When this mode is set the other 

two options, Sort by file name and Frequency cannot be set and become inactive. 

Sort by File Name 

If this option is set, all files located in the Input directory are sorted and loaded sequentially in 

alphabetical order. Application of the prediction method is done on this sorted order. 

Frequency 

The numeric Frequency box can be used to provide the frequency (in seconds) at which the 

application should poll the Input directory for new and existing input data. 

The Output tab 

The location of predicted results produced after the application of a configuration method to new or existing 

data is defined in the Output tab. This tab also allows the pre-configuration of graphical outputs to be 

displayed for a configuration method. Output tab is shown in Figure 13. 
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Figure 13 - Output Tab 

Output directory 

The Output directory provides the path for the output files. This includes three files in csv format for 

prediction: configuration summary, results, and alarms (in a subfolder). 

Numeric Format 

The Numeric Format box provides the option to print the numeric results in floating point format 

(12345.6789111) or exponential format (1.234568e+06). The selection defines how the results are 

written to the Output file. 

Plots to view (Prediction Configuration Methods Only) 

A user can select which diagnostic plot(s) to display during process monitoring. One or more of the 

following plots may be displayed 

 Y-Predictions (with or without deviations) 

 Scores (line or 2D-scatter plot) 

 Hotelling’s T
2
-statistics with limits at a specified significance level 

 Q-Residuals at a specified significance level 

 

The Display Options tab 

This tab is available for prediction configuration methods only. An example is provided in Figure 14. 
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Figure 14 - Display options tab 

Plot Window Size 

The maximum number of data points to be displayed in the plots is defined here. 

Beep If Limits Are Crossed 

An audible alarm is sounded whenever the process deviates from target conditions if this option is 

selected. 

Set Prediction Limits 

Control limits as defined by the user are entered in these fields, one for the lower control limit and 

one for the upper control limit. These limits are displayed in red in the Y-Predicted plots. If a 

predicted value falls outside of these limits an entry of the alert is written to the Alarms file. 

 

The Layout tab 

For configuration methods using prediction models, a user can select any layout from the list of nine shown 

in Figure 15. The layout should have the same number of panes as there are plots selected in the Output 

tab. 
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Figure 15 - Layout tab 

Save Configuration Method 

All of the settings (options) chosen by the user are saved as a Configuration method.  

Configuration method names can be any alphanumeric text (including some special characters like 

underscore ‘_’, hyphen ‘-‘and opening and closing brackets ‘(‘and ‘)’ ) but not a space character.  

Click the Save button to save the configuration method into the Configuration Navigator. The configuration 

method appears in the configuration navigator with the name it was saved as.  

 

3.4.2 Configuration Dialog for Classification Configuration Methods 

The Model Tab 

The Unscrambler® X model files that are to be used for classification are specified in the Model tab. Up to 

five models can be used for classification purposes. Each sample that is read into the Input directory during 

the process is classified using the specified model(s). See Figure 16 for an example. 
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Figure 16 - Model tab for Classification 

The Add Button 

Click on the Add button. The Select Model dialog (as shown in Figure 17) will appear where a user 

can browse for Unscrambler® X project or model files (as shown in Figure 18).  A standard 

windows file selection appears listing the files. 

 

 

Figure 17 - Select Model Dialog 
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Figure 18 - Open Dialog for selecting Models 

 

If The Unscrambler® X project file is password protected an Enter Password dialog box (shown in 

Figure 19) will appear. On entering the correct password, a user can see the list of models in the 

selected project file (see Figure 20). 

 

 

Figure 19 - Password dialog 

 

 

Figure 20 - Select Model 
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Select any model from the list and view the model information (see Figure 20). Click on the Add 

button to include the Classification model into the configuration method. 

Note: Only valid models (Full PLS, PCR, PCA models) can be added here. 

Up to five models can be loaded for classification purposes. Please contact your local CAMO 

Software office if a greater number of models are required for a particular application. 

Remove button 

Models can be removed from the list by selecting the model from the Model(s) list, and clicking the 

Remove button. The selected model is removed from the list. 

Components 

The number of components to be used for classification is shown in the Components numeric spin 

box. The optimum number of components for a model is suggested; however this may be modified 

by the user (provided the components were not previously saved to a model in The Unscrambler® 

X). 

For classification configuration methods, the models must all have the same transformations and 

use the same number of variables. 

Model Information 

Information about the currently highlighted model is displayed in the Model Information section. 

The Input tab 

Directory 

The sample files generated during a routine process analysis are found in a directory specified 

here. When the classification process starts, input sample files are read from this folder and used 

for classification.  The Input tab is shown in Figure 21 for a classification configuration method. A 

Browse button can be used to specify the Input directory. 
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Figure 21 - Input tab for Classification 

 

Watch for New Files 

If this option is selected, the classification process is notified whenever a new file is added to the 

Input directory. The new file is loaded and processed once any previous classifications have been 

completed. 

This option is for what is known as asynchronous mode of operation. When this mode is set the 

other two options, Sort by file name and Frequency cannot be set. 

Sort by File Name 

If this option is selected, all existing files in the Input directory are sorted and loaded sequentially in 

alphabetical order. Classification is performed on the samples in their sorted order. 

Frequency 

The numeric Frequency box can be used to provide the frequency (in seconds) at which the 

application should poll the Input directory for new data. 

 

The Output tab 

The information required for performing classification and storing the results are defined in the Output tab, 

(see Figure 22 for an example for a classification configuration method) 
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Figure 22 - Output Tab for Classification 

 

Output directory 

The Output directory defines the path for the output files which include the results file. 

 Numeric Format 

The Numeric Format box provides the option to print the numeric results in floating point format 

(12345.6789111) or exponential format (1.234568e+06). Depending on the selection, the results 

are stored in floating point or scientific notation.  

Class Significance  

Here a user selects the significance level (alpha) for class membership from the drop-down menu. 

The default value is 0.05. See Figure 22. 

 

3.5 Configuration Method Modifications 

In general, sections 3.5.1 through 3.5.3 can be performed on any configuration method available from the 

configuration navigator. Setting of passwords for protecting methods is discussed in section 3.5.4. If a 

configuration method is password protected, the functions described in sections 3.5.1 through 3.5.3 cannot 

be performed unless the password is known to the user. 
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3.5.1 Duplicate a configuration method 
 

Existing configuration methods can be duplicated in order to make small changes without deleting previous 

settings. Access this option through File –> Configuration –> Duplicate or use the designated toolbar 

button ( ). See Figure 23. 

 

Figure 23 - Duplicate Configuration Option 

 

A unique name must be provided to the duplicated method in order to save it to the configuration navigator. 

If no new name is provided, the existing method name is indexed based on the number of duplications. 

See Figure 24 for an example. 

 

Figure 24 - Duplicate Configuration Name 

 

 



Unscrambler X Process Pulse 1.0 – User Manual 

_______________________________________________________________________________________________ 

_______________________________________________________________________________________________ 
27  © Copyright CAMO Software 

3.5.2 Editing a configuration 
 

Existing configuration methods can be modified by highlighting a specific method from the configuration 

navigator list and choosing File –> Configuration –> Edit or using the designated toolbar button ( ). 

See Figure 25.  

 

Figure 25 - Edit Configuration Option 

 

3.5.3 Delete a configuration 
 

Any configuration that is no longer required can be removed by highlighting the  method in the 

configuration navigator and choosing File –> Configuration –> Delete or by clicking the Delete button 

( ). See Figure 26. 

Caution: The configuration method will be removed from the Configuration navigator as well as from the 

disk. A warning similar to that shown in Figure 27 will be provided before a configuration method can be 

deleted. 
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Figure 26 - Delete Configuration option in Menu 

 

 

Figure 27 - Confirmation message for deletion 

 

3.5.4 Setting Passwords for Configuration Methods 
 

A configuration method can be password protected in Unscrambler X Process Pulse for the prevention of 

any tampering. This is optional and was implemented to meet the basic compliance requirements of some 

organizations. The user should re-enter the password for confirmation. 

Caution: It is a user’s responsibility to record a password in a secure location in the event of forgetting it. 

Unscrambler X Process Pulse has no password recovery mechanism implemented. If such a requirement 

is necessary, contact your local CAMO Software office for more details. 

The configuration methods, protected by password, cannot be edited, deleted or duplicated without 

providing the correct password. See Figure 28, Figure 29 and Figure 30. 
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Figure 28 - Set Password for Configuration 

 

 

Figure 29 - Password Dialog 

 

 

Figure 30 - Confirmation of Password 

 

 

 

 

3.6 Run Prediction / Classification Configuration Methods 
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To use a configuration method for real time analysis, select the configuration method from the configuration 

navigator and click on the Start button in the toolbar ( ) (Figure 31) or from the menu File-> Start (Figure 

32). 

 

Figure 31 - Option for starting a Configuration Method 

 

 

Figure 32 - Option for starting Configuration 

 

If the configuration is running with ASCII data as the input file format, a window requesting the number of 

row headers in the data will appear. Enter the values for the number of row headers in the file, and the 

number of rows to be skipped (see Figure 33) 

 

 

Figure 33 - Headers for ASCII Files 

 

When the Start button is clicked, the user should enter the details of the batch/operation in the Annotation 

dialog as shown in Figure 34. Comments are added to the final results folder and the Batch ID entered can 

be searched for using the Data History option described in section 3.10. 
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Figure 34 - Annotation Dialog 

 

When the process monitoring starts the status of the prediction or classification progress is displayed in the 

bottom left corner of the main window (following normal windows software conventions).  

3.7  Running a Classification  

The output view for a classification is the Membership table, which has a column for each class model, and 

a row for each new sample being classified. The sample class is given by a one (1) in the column that 

corresponds to the sample’s class membership, with zeros (0) in the other columns (See Figure 35). 

 

Figure 35 - Example of a Class Membership Table 

3.8  Stop prediction/classification configuration method 

To stop a prediction or classification configuration method, press the Stop button ( ) in the toolbar, or 

from File -> Stop. Once this is performed, the results are saved to the Output files. Numerical results can 

be viewed by selecting View -> Data History (more details on Data History are provided in section 3.10) 
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3.9  Plot View 

The pre-configured plots, setup in the configuration method, are the default outputs for prediction methods. 

When a configuration method is started a plot window appears, see Figure 35 A maximum of four plots can 

be displayed at one time. The upper and lower limit for the Y-Predicted values, set in the Output tab, will be 

displayed. The Y-Predicted values which cross these limits are highlighted in red in the plot. As a new 

sample is read in, the corresponding Y-Predicted value is plotted in real-time. By default a scrolling graph 

is displayed with points disappearing beyond the Y-axis as set in the configuration method. 

A user can right click on any of the plots during the prediction/classification procedure and select the Save 

Plot option to save it in any of the .EMF, .BMP, .GIF, .TIFF, .JPEG, or .PNG formats. Alternatively, the 

Save All Plots option can be selected to save all the plots as a single image file in formats described 

above. 

A user can copy any of the plots to the clipboard for use in third party applications such as Microsoft Word. 

 

 

Figure 35 - Plot View as defined in the Configuration Method 

 

3.10  View Data History 

All output data, irrespective of prediction / classification, are stored and displayed in the Data History form.   

Results data are displayed based on the selected configuration. The Data History form has 3 sections (see 

Figure 36). 

1. Search – select any configuration method available from the drop down box to view the result set. Also 

available are search by date/time which will help in retrieving results between time frames. 

2. Result Set – based on the search mode, the result set generated for the configuration method will be 

displayed, ordered by time & date. A configuration method may have more than one result 

associated with it since, every time it is started, a new result set is created and relevant data are 

stored in it.  
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3. Display – click on any item in the result set and the data available in the result set will be displayed. 

This display is read only and can be used to view the output of a configuration at an instance of 

time. The contents can be copied and pasted from the display. Values can also be sorted by 

double-clicking on the column to sort on. 

 

Figure 36 - Data History 

 

3.11  Options Dialog 

 Individual Plot Settings 

Settings for individual plots can be customized from the Options dialog (Figure 37 - Options Dialog). These 

options can be customized only when a Theme is not selected. Plots can be formatted for the following 

options: 

1. Show/Hide Y axis Gridlines 

2. Show/Hide Plot header 

3. Configure the color of lines 

4. Configure the thickness of lines 

5. Configure the color of limit lines 

6. Configure the size of points to be displayed. If the size is set to zero, the points on the line are not 

shown 

7. Configure axis labels to show either Names or Numbers 

If a Theme is selected, the following options can be configured: 

1. Show/Hide Y-axis gridlines 

2. Show/Hide Plot header 

3. Configure axis labels to show either Names or Numbers 

General Options 

Number of points in scores plot  

Set the number points to be shown in a Scores Scatter plot. The default number of points shown is 

250. 
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Size of output file  

This option allows a user to set limitations on the size of the Output file. By default 20 MB is the set 

size. A user can change this option as desired. If the size of the output file exceeds this limit, a new 

file is created in the Output directory 

Antialiasing 

Enables smoother graphics, which present better on computer displays, but may look blurry in print 

format. 

Connection lines in scores 

Enables connected lines for points in scores scatter plots. 

 

Figure 37 - Options Dialog 

Label Layout 

For the Axis Label of samples and variables the text can be edited for instance by customizing the name, 

such as only having part of the name displayed. For this option use the drop-down list in Label layout for 

Samples and Variables. By default the first 10 characters of sample and variable names are shown in a 

plot. 

Enable time stamp labels 

This option can be used to show the time stamp for samples. This time stamp indicates the time 

when the sample was read from the specified folder and is the time set on the specific computer 

running Unscrambler X Process Pulse 
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Selecting a Theme 

Plots can be customized based on user preference by selecting various predefined themes. A user can 

choose from four themes available. 

 

3.12  Audit Trail 

The entire audit trail of Unscrambler X Process Pulse can be found from View -> Audit Trail (See Figure 

38). 

 

Figure 38 - Audit Trail Option 

 

The Audit trail list provides information for all the actions performed in Unscrambler X Process Pulse (see 

Figure 39 ) 

 

Figure 39 - Audit Trail Dialog 

3.13  Modify License 
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The license of Unscrambler X Process Pulse can be upgraded using the option Help -> Modify License, 

(see Figure 40) 

 

Figure 40 - Modify license dialog 
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4 Plots for Prediction 

Note: All plots can be zoomed into using the scroll button on a mouse. 

4.1 Y-Predicted Plot  

The Y-predicted plot is a simple univariate run chart of the response (Y) being predicted from the 

multivariate model assigned to the configuration method. This provides real-time values for measurements 

plotted as a function of sample (time). This plot can be displayed with limits (if they are set in the Display 

Options, see section 3.11.2). The name of the response plotted is shown in the upper right corner. If a 

model can predict more than one response, values for others can be displayed by selecting them from the 

drop-down list at the top of the plot.  The Y- predicted plot can be displayed in a number of variants, as 

designated in the configuration Output. Additional information about the raw data for a given sample and 

for variables can be accessed by double clicking on the Y-predicted plot to access drill-down plots (see 

section 4.1.5). 

The following options are available for Y-predicted plots 

1. Y-Predicted plot without deviation: This is a plot of the predicted Y values vs. sample identification 

(time) and is autoscaled for the Y-values. This plot shows the number of points set in the Options 

menu. Once this number of points has been exceeded, the plot scrolls by replacing the first result with 

the last one. See Figure 41 for an example of this plot. 

 

2. Y-Predicted plot with deviation: Y-values with deviation are plotted if designated in the Output tab. The 

deviation is an indicator of whether the predicted results are reliable, as it is a measure of the samples’ 

residual and leverage relative to the calibration data. The deviation is computed from the following 

expression 

 

Where 

ResYValVar is the residual Y-variance from the validated residual. 

ResXValSamp – is the residual X-validation variance that comes from the prediction of the new 

sample  

ResXValTot – is the average residual X-validation in the model. 

Hi is leverage of the new sample predicted relative to the calibration set 

ICal is number of calibration samples 

a is the number of factors/components in the calibration model 

See Figure 42 for an example of this plot type. 
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Figure 41 - Y-Predicted plot with upper and lower limits without deviations 

 

 

Figure 42 - Y-Predicted plot with upper and lower limits with deviations 

 

4.2 Scores Plot  

The scores space from a multivariate prediction model is a measure of the total variance in the data with 

respect to a calibration set. A plot of the scores, though not quantitative, provides a means to trend the 

variance in sample data. It can also serve as a visualization of the similarity of samples with respect to 

each other, when viewed either as a line or a 2D scatter plot. 

The following options are available for scores plots 

1. Scores Line plot: The scores line plot is displayed for the highest number of PCs in a model for each 

new sample predicted, and is shown with the Hotelling T
2
 limit lines at that number of PCs in the 

model.   The upper and lower limits for the Hoteling T
2
 lines are based on the points where the overall 

confidence ellipse would cross the PC axes, if the scores were plotted as a 2D graph.  To change the 

view to another PC, select the desired PC from the drop-down list in the upper right hand corner. See 

Figure 43 for an example line scores plot. 
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2. Scores Scatter plot (with Hotelling’s T
2
 ellipse): When the scores are plotted as a scatter plot, the 

default plot is of PC1 vs. PC2. Other 2-D scatter plot combinations can be chosen from the drop-down 

menu. In this view (with the Default theme) the last point predicted is shown as a larger green dot. 

Samples outside the limits are displayed as red dots. The last 10 points are shown in blue, and older 

points are shown in grey for the default settings of the plot. The points color scheme is changed based 

on the Theme selected. See Figure 44 for an example of a 2-D scatter scores plot. 

 

 

Figure 43 - Scores Line plot with limits 

 

 

Figure 44 - Scores Scatter plot with Hotelling’s T2 Ellipse 

 

4.3 Hotelling’s T
2
–statistics with limits 

During process monitoring outlier statistics are powerful tools for identifying if samples are different to 

those used in the calibration set. Such outlier statistics are used for detecting process deviations, potential 

process upsets or measurement issues. The Hotelling’s T
2
 limit is calculated based on the calibration 

samples, and based on a user-specified significance level (0.1, 0.5, 1.0, 5.0, 10.0, and 25.0%). The limit 

serves as outlier detection for newly measured samples and those exceeding the limits are deemed 
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outliers. Such samples are well explained by the model but represent extreme variation and should be 

further investigated. Contribution plots for the Hotelling’s T
2
 plot can aid in finding the root cause of an 

outlying sample. See Figure 45 for an example of the Hotelling’s T
2
 statistics plot with limits. 

  

Figure 45 - Hotelling T2 Plot with limits 

 

4.4 Q-Residuals Plot   

Another valuable outlier detection statistic in process monitoring is the Q residuals, which are related to the 

variance in the variables (e.g. a sample spectrum) that is not explained by the model being used. Samples 

whose Q-residual values exceed the limit line might be considered as outliers and should be further 

investigated to identify the root cause of the difference. Figure 46 provides an example of a Q-Residuals 

plot. 

 

Figure 46 - Q-Residuals Plot with limits 
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4.5 Raw Data Drill-down Plot  

In the situation where more information is required about a predicted sample, this can be obtained by 

double-clicking on a sample point in the Y-predicted or Scores plot.  This will open a two-plot view 

consisting of the Raw Data, and the Min/Max/Mean plot for the selected point. The Min/Max/Mean plot 

(which is a variation on a box and whisker plot) is used to isolate any variable(s) that are different with 

respect to those of the calibration set. This plot can be shown with data centered and scaled by clicking the 

icon in the upper right corner ( ), which is particularly useful if the variables are of different units and 

scales .See Figure 47 for an example of this plot. 

  

Figure 47 -Raw Data plot compared to Calibration data 

 

4.6 Raw Data Double Drill-down Plot  

A further drill-down plot of the values for a selected variable and the 10 samples around can be displayed 

by double-clicking on a variable in the raw data plot. The name of the variable being displayed is shown in 

the window header. The value for the selected sample is shown as a hashed bar (in bar plot view), with the 

other samples shown as filled bars. Lines for the minimum and maximum values of the variable in the 

calibration set area also on the plot, and the values in the plot title. The plot may also be displayed as a line 

plot, and the selected sample point will be displayed larger than the other points in the plot (see Figure 48) 
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Figure 48 - Double drill-down for raw data plot 

 

4.7 Contribution Plot for Hotelling’s T
2
-Plot 

Contribution plots are used in process monitoring to indicate the contribution of each variable to a 

measured statistic such as the Hotelling’s T
2
 or Q residuals. They aid in determining which variable(s) 

contribute to a sample being outside the limits for the statistic.  High contribution values may be indicative 

of a problem with that variable, and are therefore useful in fault detection.  

The contribution plot is opened by double clicking on a sample point in the Hotelling’s T
2
 or Q Residuals 

plot which opens two contribution plots in a new window. The upper plot shows the contribution of each 

variable to the Hotelling’s T
2
 (as a bar) in the order of the variables. A line on the plot shows the model’s 

average for the Hotelling’s T
2
 values. This shows how much each variable for the selected sample differs 

from the model’s average values – a good means of identifying what may be plausible variables related to 

faults. If both the Hotelling’s T
2
 and Q-Residuals are chosen in the output display, contribution plots for 

both will open. 

The contributions of each variable for a selected sample are shown, and can be sorted in 

ascending/descending order. The bar plot can be changed to a line plot by toggling the icon in the upper 

right corner ( ) ( Figure 49)  

 

Figure 49 - Contribution plot for Hotelling’s T2-statistics 

 

 

4.8 Contribution Plot for Q-Residual Plot 

The contribution plot for the Q residuals is opened by double clicking on a sample point in the Q Residuals 

or Hotelling’s T
2
 plot. The lower of the two contribution plots show the contribution of each variable to the Q 

residuals (as a bar) in the order of the variables. A line on the plot shows the model’s average for the Q 

residual values. This shows how much each variable for the selected sample differs from the model’s 

average values – a good means of identifying what may be plausible variables related to faults. 

The contributions for each variable for the selected sample are shown, and can be sorted in 

ascending/descending order. The bar plot can be changed to a line plot by toggling the icon in the upper 

right corner ( ) (See Figure 50). 
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Figure 50 - Contribution plot for Q-Residuals 
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5 Output files 

Up to five files are generated when a configuration method is run, and are found in the Output folder. The 

Analysis Result file in Unscrambler X Process Pulse format is in the output folder, while the other files are 

in a subfolder with the name of the configuration method.  

1. Unscrambler X Process Pulse results (Configuration name dd-mm-yyyy-hh-mm-ss.upp)  

2. The configuration summary file (ConfigSummary_dd-mm-yyyy-hh-mm-ss.csv)  

3. The results file (configuration name-dd-mm-yyyy-hh-mm-ss.csv) 

4. An error log (configuration name_ErrorLog_dd-mm-yyyy-hh-mm-ss.txt) 

5. An alarms file (Alarms_configuration name_dd-mm-yyyy-hh-mm-ss.csv 

For Classification only two output files are created: the *.upp and the results file in the folder with the 

configuration method name. 
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